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Abstract. The purpose of this research is to identify whether the result of the students learning 
Islamic education using the method of the power of two better than the students leaning Islamic 
education using the method of power of two in X grade of Sekolah Menengah Atas Negeri 
(SMAN) 1 Tanah Sepenggal. The typical of this research is Quasi Experimental Research with 
research plan of randomize control group only design. The population in this research is all of X 
grade students of SMAN 1 Tanah Sepenggal in 2017/2018. The result of this research illustrates 
that the average acquisition of experimental class test mark is 80 and control class is 73,6. It is 
clear that there is a significant difference of learning result between the method of listening team and 
the method of the power of two in Islamic education lesson. 

Keywords: Learning Result, Cooperative Learning, The Method of Listening Team, The 
Method of The Power Of Two   

 
Abstrak. Tujuan penelitian ini adalah untuk mengetahui apakah hasil belajar Pendidikan 

Agama Islam (PAI) peserta didik yang pembelajarannya menggunakan metode the power of two 

lebih baik dari hasil belajar PAI peserta didik yang pembelajarannya menggunakan metode 

listening team pada materi pokok nikmatnya menuntut ilmu dan indahnya berbagi pengetahuan 

pada peserta didik kelas X Sekolah Menengah Atas Negeri (SMAN) 1 Tanah Sepenggal. Jenis 

penelitian ini adalah eksperimen-semu (Quasi Experimental Research) dengan rancangan 

penelitian randomize control group only desain. Populasi dalam penelitian ini adalah seluruh 

peserta didik kelas X SMAN 1 Tanah Sepenggal tahun ajaran 2017/2018. Hasil penelitian 

menunjukkan bahwa perolehan rata-rata nilai tes kelas eksperimen adalah 80 dan rata-rata nilai 

tes kelas kontrol adalah 73,6. Persentase ketuntasan belajar peserta didik kelas eksperimen 

adalah 76,67%, sedangkan pada kelas kontrol 53%. Dan terdapat perbedaan hasil belajar yang 

signifikan antara metode listening team dengan metode the power of two pada pelajaran PAI. 

 
Kata kunci: Hasil Belajar, Pembelajaran Kooperatif, Metode Listening Team, Metode The 

Power of Two 

 

 
Vol. 9 No. 1 Mei 2022 (pp. 16- 27)  DOI: 10.17509/t.v9i1.46466 
ISSN   : 2580-6181 (Print),  2599-2481 (Online)  
Available online at: https://ejournal.upi.edu/index.php/tarbawy/index 

mailto:adriantoni@adzkia.ac.id


Metode Kooperatif Tipe Listening Team dan  
Tipe The Power of Two dalam Pembelajaran Pendidikan Agama Islam 

TARBAWY: Indonesian Journal of Islamic Education – Vol. 9 No. 1 (2022) | 17 

 
 
 

PENDAHULUAN 

 

Pendidikan merupakan kebutuhan 

hidup setiap manusia karena tidak ada 

satu orang pun yang dilahirkan 

membawa ilmu (kepandaian). 

Kebutuhan ini sangat penting dan 

mutlak, karena tingginya derajat 

manusia ditentukan oleh tingkat iman 

dan ilmu pengetahuan serta 

pendidikan yang dimilikinya. Dalam 

Undang-Undang RI No 20 Tahun 

2003 tentang Sistem Pendidikan 

Nasional Bab I dan Pasal 1 

mendefinisikan pendidikan sebagai 

usaha sadar dan terencana untuk 

mewujudkan suasana belajar dan 

proses pembelajaran agar peserta didik 

secara aktif mengembangkan potensi 

dirinya untuk kepribadian, kecerdasan, 

akhlak mulia, serta terampil yang 

diperlukan dirinya, masyarakat, bangsa, 

dan negara (Undang-Undang RI 

No.20 Tahun 2003, 2016: h. 2). 

Pendidikan agama Islam 

adalah usaha sadar untuk menyiapkan 

peserta didik dalam meyakini, 

memahami, menghayati, dan 

mengamalkan agama Islam melalui 

kegiatan bimbingan, pengajaran, dan 

latihan dengan memperhatikan 

tuntutan, untuk menghormati agama 

lain dan hubungan kerukunan antar 

umat beragama dalam masyarakat 

untuk mewujudkan persatuan nasional 

(Saiful Bahri Djamarah, 1997: h. 48). 

Sementara pendidikan agama 

Islam menurut Ramayulis yaitu upaya 

sadar dan terencana dalam 

menyiapkan peserta didik untuk 

mengenal, memahami, menghayati, 

mengimani, bertakwa, berakhlak 

mulia, mengamalkan ajaran agama 

Islam dari sumber utamanya kitab suci 

al-Qur’an dan al-Hadits, melalui 

kegiatan bimbingan, pegajaran latihan, 

serta penggunaan pengalaman 

(Ramayulis, 2005: h. 21). 

Proses pendidikan harus 

mengacu kepada tujuan pendidikan, 

secara umum tujuan pendidikan 

membawa ke arah kedewasaan 

sedangkan dalam Undang-Undang RI 

No 20 Tahun 2003 tentang sistem 

pendidikan nasional pasal 3 

menyatakan bahwa pendidikan 

bertujuan untuk berkembangnya 

potensi peserta didik agar menjadi 

manusia yang beriman dan bertaqwa 

kepada Tuhan Yang Maha Esa, 

berakhlak mulia, cakap, kreatif, 

mandiri dan menjadi warga Negara 

yang demokratis serta 
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bertanggungjawab (UU No 20 Tahun 

2003, 2003: h. 11). 

Perumusan tujuan pendidikan 

merupakan masalah sentral dalam 

pendidikan karena tanpa perumusan 

yang jelas tentang tujuan pendidikan, 

perbuatan menjadi acak-acakan, tanpa 

arah, bahkan bisa sesat atau salah 

langkah.  

Agar tujuan pendidikan bisa 

tercapai, maka perlu diperhatikan 

segala sesuatu yang mendukung 

keberhasilan program pendidikan. 

Dalam proses pembelajaran itulah 

terjadinya internalisasi nilai-nilai dan 

pewarisan budaya maupun norma-

norma secara langsung. Karena itu, 

kegiatan belajar mengajar merupakan 

“ujung tombak” untuk tercapainya 

pewarisan nilai-nilai di atas. Untuk itu, 

perlu sekali dalam proses pembelajaran 

diciptakan suasana kondusif agar 

peserta didik benar-benar tertarik dan 

ikut aktif dalam proses belajar 

mengajar. 

Salah satu hal yang sangat 

penting dalam proses pembelajaran 

adalah metode yang digunakan oleh 

seorang pendidik dalam menyampaikan 

suatu materi pembelajaran. Berkenaan 

dengan metode, al-Qur’an telah 

memberikan petunjuk mengenai 

metode pendidikan secara umum 

dalam surah An-Nahl ayat 125 : 

  
 
 


 


 

  
 
 

   
  
  

   
  

  


     : النحل(
125) 

 
Artinya:“Serulah (manusia) kepada jalan 
Tuhan-mu dengan hikmah dan pelajaran 
yang baik dan bantahlah mereka dengan 
cara yang baik. Sesungguhnya Tuhanmu 
Dialah yang lebih mengetahui tentang siapa 
yang tersesat dari jalan-Nya dan Dialah 
yang lebih mengetahui orang-orang yang 
mendapat petunjuk”. (QS. An-Nahl: 125) 
(Departemen RI, 2005: h. 282). 
 

Pembelajaran PAI di SMA N 1 

Tanah Sepenggal belum sesuai dengan 

apa yang diharapkan. Terdapat beberapa 

kendala yang dihadapi dalam 

pembelajaran PAI salah satunya adalah 

kurangnya pemahaman peserta didik 

terhadap materi-materi yang diajarkan 

oleh pendidik. Kondisi tersebut 

disebabkan oleh berbagai hal, di 

antaranya yaitu: peserta didik kurang 

memperhatikan materi yang 
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disampaikan karena munculnya rasa 

bosan dengan metode  pembelajaran 

yang monoton yaitu lebih banyak 

didominasi oleh pendidik, cara 

mengajar pendidik kurang menarik, 

sehingga pembelajaran yang 

berlangsung kurang bermakna dan 

terasa membosankan bagi peserta 

didik. Akibatnya hasil belajar peserta 

didik menjadi relatif rendah. 

Salah satu metode pembela-

jaran yang membuat peserta didik 

lebih aktif dan antusias dalam proses 

pembelajaran adalah metode 

pembelajaran kooperatif tipe the power of 

two  yang dikenal dalam bahasa 

Indonesia dengan metode “kekuatan 

dua kepala”, metode ini merupakan 

aktivitas pembelajaran yang digunakan 

untuk mendorong pembelajaran 

kooperatif dan memperkuat arti 

penting serta manfaat sinergi dua 

orang. Metode ini mempunyai prinsip 

bahwa berpikir berdua jauh lebih baik 

daripada berpikir sendiri (Hisyam 

Zaini, 2013: h. 55). 

Metode pembelajaran koope-

ratif ini memiliki banyak tipe, salah 

satu metode pembelajaran kooperatif 

yang sudah diterapkan oleh pendidik 

di kelas X SMAN 1 Tanah Sepenggal 

adalah tipe listening team atau yang 

dikenal dalam bahasa Indonesia 

dengan tim pendengar, pembelajaran 

yang menggunakan metode ini di awali 

dengan pemaparan materi oleh 

pendidik, selanjutnya pendidik 

membagi peserta didik ke dalam empat 

kelompok dan setiap kelompok 

mempunyai peran masing-masing yaitu 

kelompok pertama berperan sebagai 

penanya, kelompok kedua dan ketiga 

adalah penjawab, dan kelompok 

keempat adalah kelompok yang 

bertugas untuk membuat kesimpulan 

dari hasil diskusi. Pembelajaran 

diakhiri dengan penyampaian berbagai 

kata kunci atau konsep yang telah 

dikembangkan oleh peserta didik 

dalam berdiskusi (Istarani, 2012: h. 

235). 

Penggunaan metode pembela-

jaran kooperatif tipe the power of two ini 

merupakan suatu upaya untuk 

meningkatkan aktivitas dan kreatifitas 

belajar peserta didik. Dengan 

menerapkan metode ini nantinya dapat 

mengatasi kesulitan dan menarik 

perhatian peserta didik dalam 

pembelajaran di kelas. Dengan 

demikian, hasil belajar peserta didik  

akan meningkat dan tujuan 

pembelajaran pun tercapai. 

 

METODE PENELITIAN  
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Penelitian ini merupakan penelitian 

eksperimen semu (quasi a experimental 

research), cara pelaksanaan dan waktu 

penelitian telah ditentukan. Penelitian 

ini dilakukan terhadap dua kelas, yaitu 

kelas eksperimen dan kelas kontrol. 

Pada kelas eksperimen peserta didik 

diberikan dengan metode The Power Of 

Two. Sedangkan pada kelas kontrol 

peserta didik diberikan dengan metode 

listening team. Rancangan penelitian 

yang digunakan adalah randomize control 

group only desain. Dalam rancangan ini 

sekelompok subjek yang diambil dari 

populasi tertentu dikelompokkan 

secara rambang menjadi dua 

kelompok yaitu kelompok eksperimen 

dan kelompok kontrol (Sumadsi 

Suryabrata, 2003: h. 117). 

Populasi dalam penelitian ini 

adalah seluruh peserta didik  kelas X 

SMAN 1 Tanah Sepenggal Kabupaten 

Bungo yang terdaftar pada tahun 

pelajaran 2017/2018. Peserta didik 

kelas X terdiri dari delapan kelas. 

 

No Kelas Jumlah Peserta 
Didik 

1 IPA 1 33 
2 IPA 2 31 
3 IPA 3 30 
4 IPA 4 30 
5 IPS 1 33 
6 IPS 2 32 
7 IPS 3 32 
8 IPS 4 32 

Jumlah 253 
 

Tabel 1 
Daftar Jumlah Peserta Didik  Kelas X 
SMA N 1 Tanah Sepenggal Semester 2 

Tahun Ajaran 2017/2018 

(Sumber : Tata Usaha SMAN 1 Tanah 
Sepenggal Kabupaten Bungo) 

Sampel adalah penarikan 

sebagian populasi untuk mewakili 

seluruh populasi. Pengambilan 

pertama terpilih kelas X IPA 3 dan 

dijadikan sebagai kelas eksperimen. 

Pengambilan kedua terpilih kelas X 

IPA 4 dan dijadikan sebagai kelas 

kontrol. 

Prosedur penelitian dilakukan 

dengan tiga tahapan sebagai berikut: 

(1) Tahap Persiapan Pada Tahap ini 

dipersiapkan sesuatu yang 

dipergunakan dalam penelitian yaitu: 

Menetapkan tempat penelitian, 

menentukan jadwal penelitian, 

mempersiapkan kelas eksperimen dan 

kontrol, mempersiapkan rencana 

pelaksanan pembelajaran sebagai 

pedoman dalam proses pembelajaran, 

mempersiapkan kisi-kisi soal tes uji 

coba hasil belajar yang akan diberikan 

pada peserta didik di akhir 

pembelajaran, mempersiapkan soal tes 

hasil belajar yang akan diberikan 

kepada peserta didik pada akhir 

pembelajaran. Melakukan uji coba. (2) 

Tahap pelaksanaan Pembelajaran pada 
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kelas eksperimen dan kelas kontrol 

adalah sama dari segi materi. Kedua 

kelas sampel hanya dibedakan dalam 

metode pembelajaran yang digunakan. 

(3) Tahap Akhir Memberikan tes akhir 

kepada kedua kelas sampel setelah 

penelitian berakhir, guna melihat hasil 

perlakuan yang telah diberikan, 

Mengolah data dari kedua kelas 

sampel, Memberikan kesimpulan dari 

hasil yang diperoleh sesuai dengan 

teknis analisis yang digunakan. 

Teknik pengumpulan data yang 

digunakan oleh peneliti dalam 

penelitian ini adalah menggunakan tes 

hasil belajar. Teknik analisis data yang 

digunakan dalam penelitian ini adalah 

analisis perbedaan dengan 

menggunakan rumus t-test. Dengan 

analisis data ini, maka langkah-langkah 

yang dilakukan adalah sebagai berikut: 

1. Uji Normalitas 

Uji normalitas bertujuan 

untuk melihat apakah kedua kelas 

sampel berdistribusi normal atau 

tidak. Pengujian  normalitas  data  

dengan menggunakan program 

SPSS versi 16 dengan langkah-

langkah: Memasukan data hasil 

belajar kelas eksperimen dan kelas 

kontrol > Klik Analyze > 

Descriptive Statistics > Explore > 

Dependent List > Plots > Klik 

Faktor Levels Together > Klik 

Histogram > Klik Normality Plots 

With Test > Klik Continue. 

2. Uji Homogenitas 

Uji homogenitas bertujuan 

untuk menyelidiki apakah kedua 

kelompok sampel mempunyai 

variansi yang homogen atau tidak.  

Pengujian homogenitas 

data dalam penelitian ini 

menggunakan program SPSS versi 

16 dengan langkah-langkah berikut: 

Memasukan data hasil belajar kelas 

eksperimen dan kelas kontrol > 

Klik Analyze > Klik Compare 

Means > Klik One Way ANOVA 

> Dependent List > Klik Options 

> Klik Descriptive > Klik 

Homogenety of variance test > 

Klik Means Plot > Klik Continue. 

3. Uji Hipotesis 

Pengujian hipotesis dalam 

penelitian ini menggunakan 

program SPSS versi 16 dengan 

langkah-langkah sebagai berikut : 

Memasukan data hasil belajar kelas 

eksperimen dan kelas 

kontrol>Klik Analyze>Klik 

Compare Means>Klik One 

sampel T test>Klik Options>Klik 

exclude cases analysis> Klik 

Continue. 
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HASIL PENELITIAN DAN 

PEMBAHASAN 

 

 

1. Gambaran Hasil Belajar Setelah 

Dilakukan Pre Test Pada Kelas 

Kontrol Yaitu Kelas X IPA 4 

SMAN 1 Tanah Sepenggal 

 

Untuk mendapatkan gambaran pre 

test pada kelas Kontrol yaitu kelas X 

IPA 4 di SMAN 1 Tanah Sepenggal 

dilakukan dengan tes. Rumusnya:  

 = Nilai tertinggi - Nilai terendah + 1 

  5 

Untuk mengetahui distribusi 

frekuensi hasil belajar pre test kelas 

kontrol dapat dilihat pada tabel 2. 

Sedangkan untuk mendapatkan jumlah 

persentase dilakukan dengan cara 

membagi frekuensi yang sedang dicari 

frekuensinya dengan jumlah frekuensi 

atau banyaknya individu dan dikali 

seratus. 

 

Klasifikasi 
Inter-

val 
Frek-
uensi 

Persen-
tase 

Sangat 
Tinggi 

76-84 
7 23% 

Tinggi 67-75 4 14% 
Sedang 58-66 7 23% 
Rendah 49-57 6 20% 

Sangat 
Rendah 

≤ 48 
6 20% 

Jumlah 30 100% 

 
Tabel 2 

Distribusi Frekuensi Hasil Belajar Pre 
Test Kelas Kontrol 

 
Berdasarkan data yang 

disajikan pada tabel 2 di atas diperoleh 

peserta didik yang terdiri atas kategori 

sangat tinggi, tinggi, sedang, rendah, 

dan  sangat rendah. Peserta didik yang 

memiliki kategori hasil pre test sangat 

tinggi dan tinggi masing-masing 

berjumlah 7 orang dan 4 orang dengan 

persentase masing-masing (23%) dan 

(14%), berkategori sedang berjumlah 7 

orang dengan persentase (23%), 

sedangkan peserta didik yang 

berkategori rendah dan sangat rendah 

masing-masing berjumlah 6 orang 

dengan persentase masing-masing 

(20%). Bila dilakukan penjumlahan 

nilai, maka didapat mean sebesar 62,53 

berkategori sedang yaitu pada interval 

58-66. 

 

2. Gambaran Hasil Belajar Setelah 

Dilakukan Pre Test Pada Kelas 

Eksperimen Yaitu Kelas X IPA 

3 SMAN 1 Tanah Sepenggal 

 

Untuk mendapatkan gambaran pre 

test pada kelas eksperimen yaitu kelas 
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X IPA 3 di SMAN 1 Tanah Sepenggal 

dilakukan dengan tes. Rumusnya:  

 = Nilai tertinggi - Nilai terendah + 1 

  5 

Untuk mengetahui distribusi 

frekuensi hasil pre test kelas 

eksperimen dapat dilihat pada tabel 3 

Sedangkan untuk mendapatkan jumlah 

persentase dilakukan dengan cara 

membagi frekuensi yang sedang dicari 

frekuensinya dengan jumlah frekuensi 

atau banyaknya individu dan dikali 

seratus. 

 
Klasifika

si 
Inter-

val 
Frek-
uensi 

Persen-
tase 

Sangat 
Tinggi 

76-84 
9 30% 

Tinggi 67-75 4 13% 
Sedang 58-66 4 13% 
Rendah 49-57 6 20% 
Sangat 
Rendah 

≤ 48 
7 24% 

Jumlah 30 100% 

Tabel 3 
Distribusi Frekuensi Hasil Belajar Pre-

Test Kelas Eksperimen. 
 

Berdasarkan data yang 

disajikan pada tabel 3 diatas diperoleh 

subjek yang terdiri atas kategori sangat 

tinggi, tinggi, sedang, rendah, sangat 

rendah. Peserta didik yang memiliki 

hasil pre test sangat tinggi dan tinggi 

masing-masing berjumlah 9 orang dan 

4 orang dengan persentase masing-

masing (30%) dan (13%), peserta didik 

yang berkategori sedang berjumlah 4 

orang dengan persentase (13%). 

Sedangkan pada kategori rendah dan 

sangat rendah masing-masing 

berjumlah 6 orang dan 7 orang dengan 

persentase masing-masing (20%) dan 

(24%). Bila dilakukan penjumlahan 

nilai, maka didapat mean sebesar 62,93 

berkategori sedang yaitu berkisar pada 

interval 58 - 66. 

 

3. Gambaran Hasil Belajar Pos 

Test Kelas Kontrol Yang 

Menggunakan Metode 

Listening Team pada Mata 

Pelajaran PAI Kelas X IPA 4 

SMAN 1 Tanah Sepenggal 

 

Untuk mendapatkan gambaran pos 

test pada kelas Kontrol yaitu kelas X 

IPA 4 di SMAN 1 Tanah Sepenggal 

dilakukan dengan tes. Rumusnya:  

 = Nilai tertinggi - Nilai terendah + 1 

  5 

Untuk mengetahui distribusi 

frekuensi hasil pos test  kelas kontrol 

dapat dilihat pada tabel 4. Sedangkan 

untuk mendapatkan jumlah persentase 

dilakukan dengan cara membagi 

frekuensi yang sedang dicari 

frekuensinya dengan jumlah frekuensi 

atau banyaknya individu dan dikali 

seratus.  

Klasifikasi Inter- Frek- Persen-
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val uensi tase 
Sangat 
Tinggi 

82-88 
6 20% 

Tinggi 75-81 10 33% 
Sedang 68-74 8 27% 
Rendah 61-67 3 10% 
Sangat 
Rendah 

82-88 
6 20% 

Jumlah 30 100% 

Tabel 4 
Distribusi Frekuensi Hasil Belajar Pos 

Test Kelas Kontrol 
Berdasarkan data yang 

disajikan pada tabel 4 diatas diperoleh 

subjek yang terdiri atas kategori sangat 

tinggi, tinggi, sedang, rendah, sangat 

rendah. Peserta didik yang memiliki 

kategori hasil pos test sangat tinggi 

dan tinggi masing-masing berjumlah 6 

orang dan 10 orang dengan persentase 

masing-masing (20%) dan (33%), pada 

kategori sedang berjumlah 8 orang 

dengan persentase (27%). Sedangkan 

pada kategori rendah dan sangat 

rendah masing-masing berjumlah 3 

orang dengan persentase masing-

masing (10%). Bila dilakukan 

penjumlahan nilai, maka didapat mean 

sebesar 73,6 berkategori sedang, yaitu 

berkisar pada interval 68-74. 

4. Gambaran Hasil Belajar Pos 

Test Kelas Eksperimen yang 

Menggunakan Metode 

Kooperatif  Tipe The Power Of  

Two pada Mata Pelajaran PAI 

Kelas X IPA 3 SMAN 1 Tanah 

Sepenggal 

Untuk mendapatkan gambaran 

pos test pada kelas Eksperimen yaitu 

kelas X IPA 3 di SMAN 1 Tanah 

Sepenggal, dilakukan dengan tes. 

Rumusnya:  

 = Nilai tertinggi - Nilai terendah + 1 

  5 

Untuk mengetahui distribusi 

frekuensi hasil pos test  kelas 

eksperimen dapat dilihat pada tabel 5. 

Sedangkan untuk mendapatkan jumlah 

persentase dilakukan dengan cara 

membagi frekuensi yang sedang dicari 

frekuensinya dengan jumlah frekuensi 

atau banyaknya individu dan dikali 

seratus.  

 

Klasifikasi 
Inter-

val 
Frek-
uensi 

Persen
-tase 

Sangat Tinggi 86-92 10 34% 
Tinggi 79-85 9 30% 
Sedang 72-78 6 20% 
Rendah 65-71 2 6% 
Sangat 
Rendah 

≤ 64 
3 10% 

Jumlah 30 100% 

Tabel 5 
Distribusi Frekuensi Hasil Belajar Post 

Test Kelas Eksperimen 
 

Berdasarkan data yang 

disajikan pada tabel 5 diatas diperoleh 

subjek yang terdiri atas kategori sangat 

tinggi, tinggi, sedang, rendah, sangat 

rendah. Peserta didik yang memiliki 

kategori hasil pos test sangat tinggi 

dan tinggi masing-masing berjumlah 

10 orang dan 9 orang dengan 
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persentase masing-masing (34%) dan 

(30%), pada kategori sedang berjumlah 

6 orang dengan persentase (20%). 

Sedangkan pada kategori rendah dan 

sangat rendah masing-masing 

berjumlah 2 orang dan 3 orang dengan 

persentase masing-masing (6%) dan 

(10%). Bila dilakukan penjumlahan 

nilai, maka didapat mean sebesar 80,53 

berkaegori tinggi, yaitu berkisar pada 

interval 79-85. 

5. Perbedaan Hasil Belajar 

Pendidikan Agama Islam 

antara Metode Listeninng 

Team dengan Metode The 

Power Of Two pada Peserta 

Didik pada Kelas X SMAN 1 

Tanah Sepenggal 

 

Berdasarkan Uji-t dengan SPSS versi 

16 atau hasil analisis diperoleh 𝛼 𝑠𝑖𝑔 dalam dua sisi atau sig (2-tailed) 

sebesar = 0,000 maka dapat diambil 

kesimpulan bahwa (0,000 < 0,025) 

dalam uji dua sisi. Hal ini berarti  𝐻0 

yang berbunyi tidak terdapat 

perbedaan hasil belajar antara peserta 

didik yang menggunakan metode  

listening team dengan peserta didik  yang 

menggunakan metode  the power of two 

ditolak dan 𝐻𝑎  diterima, yang artinya 

terdapat perbedaan hasil belajar antara 

Metode listening team dengan metode 

the power of two. Dengan demikian, 

dapat disimpulkan bahwa hasil belajar 

PAI peserta didik dengan Penerapan 

metode Kooperatif tipe The Power Of 

Two lebih baik dari pada hasil belajar 

PAI peserta didik yang menggunakan 

Metode listening team. 

 

KESIMPULAN 

Hasil belajar pre test peserta didik 

dikelas kontrol adalah peserta didik 

yang memiliki kategori hasil pre test 

sangat tinggi berada pada interval 76-

84 yang berjumlah 7 orang,  

berkategori tinggi berada pada interval 

67-75 berjumlah 4 orang, berkategori 

sedang berada pada interval 58-66 

berjumlah 7 orang, berkategori rendah 

berada pada interval 49-57 berjumlah 

6 orang, sedangkan yang berkategori 

sangat rendah berada pada interval ≤ 

48 yang berjumlah 6 orang. Dengan 

demikian dapat disimpulkan, rata-rata 

gambaran pre test hasil belajar kelas 

kontrol mata pelajaran PAI di kelas X 

IPA 4 SMA N 1 Tanah Sepenggal 

adalah 62,53 berada pada kategori 

sedang.         

Hasil belajar pre test peserta 

didik di kelas eksperimen adalah 

peserta didik yang memiliki kategori 

hasil pre test sangat tinggi berada pada 
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interval 76-84 yang berjumlah 9 orang, 

berkategori tinggi berada pada interval 

67-75 berjumlah 4 orang,  berkategori 

sedang berada pada interval 58-66 

berjumlah 4 orang, berkategori rendah 

berada pada interval 49-57 berjumlah 

6 orang, sedangkan yang berkategori 

sangat rendah berada pada interval ≤ 

48 berjumlah 7 orang. Dengan 

demikian dapat disimpulkan, rata-rata 

gambaran pre test hasil belajar kelas 

eksperimen mata pelajaran PAI di 

kelas X IPA 3 SMA N 1 Tanah 

Sepenggal adalah 62,93 berada pada 

kategori sedang.         

Hasil belajar pos test peserta 

didik di kelas kontrol adalah peserta 

didik yang memiliki kategori hasil pos 

test sangat tinggi berada pada interval 

82-88 yang berjumlah 6 orang, 

berkategori tinggi berada pada interval 

75-81 berjumlah 10 orang, berkategori 

sedang berada pada interval 68-74 

berjumlah 8 orang, berkategori rendah 

pada interval 61-67 berjumlah 3 orang, 

sedangkan yang berkategori sangat 

rendah berada pada interval ≤ 60 

berjumlah 3 orang. Dengan demikian 

dapat disimpulkan, rata-rata gambaran 

pos test hasil belajar kelas kontrol 

mata pelajaran PAI di kelas X IPA 4 

SMA N 1 Tanah Sepenggal adalah 

73,6 berada pada kategori sedang.      

Hasil belajar pos test peserta 

didik di kelas kontrol adalah peserta 

didik yang memiliki kategori hasil pos 

test sangat tinggi berada pada interval 

82-88 yang berjumlah 6 orang, 

berkategori tinggi berada pada interval 

75-81 berjumlah 10 orang, berkategori 

sedang berada pada interval 68-74 

berjumlah 8 orang, berkategori rendah 

pada interval 61-67 berjumlah 3 orang, 

sedangkan yang berkategori sangat 

rendah berada pada interval ≤ 60 

berjumlah 3 orang. Dengan demikian 

dapat disimpulkan, rata-rata gambaran 

pos test hasil belajar kelas kontrol 

mata pelajaran PAI di kelas X IPA 4 

SMA N 1 Tanah Sepenggal adalah 

73,6 berada pada kategori sedang.      

Berdasarkan uji hipotesis atau 

hasil analisis diperoleh 𝛼 𝑠𝑖𝑔 dalam 

dua sisi atau sig (2-tailed) ) sebesar = 

0,000 maka dapat diambil kesimpulan 

bahwa (0,000 < 0,025) dalam uji dua 

sisi. Maka 𝐻0 di tolak dan 𝐻𝑎 diterima, 

yang artinya terdapat perbedaan hasil 

belajar antara Metode listening team 

dengan metode the power of two. 

Kepada kepala sekolah 

khususnya kepala sekolah SMAN 1 

Tanah Sepenggal agar megarahkan 

para pendidik untuk menggunakan 

metode yang tepat dalam pembelajaran, 

salah satunya metode Kooperatif Tipe 
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The Power Of Two yaitu  sebagai salah 

satu metode yang dapat meningkatkan 

hasil belajar peserta didik. 

Diharapkan guru PAI SMA 

umumnya, khususnya guru di SMAN 

1 Tanah Sepenggal dapat menerapkan 

metode bervariasi khususnya metode 

the power of two dalam pembelajaran 

PAI sebagai salah satu alternatif untuk 

meningkatkan hasil belajar PAI peserta 

didik. 

Bagi peneliti berikutnya 

penerapan metode the power of two  

harus lebih di kondisikan dan 

dipersiapkan dengan lebih baik dengan 

waktu se-efisien mungkin, sehingga 

proses pembelajaran dapat berjalan 

lebih baik dan memberikan hasil yang 

lebih memuaskan. 
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